Introduction to ERD modelling using UML Class diagrams with Magicdraw (ver 17)

Robin Beaumont  robin@organplayers.co.uk  Tuesday, 04 October 2011

Contents:

1. Introduction .................................................................................................................................................. 2
   1.1. Acknowledgement.................................................................................................................................. 2
   1.2. Where to obtain the software.................................................................................................................. 2
   1.3. Before you begin this tutorial?............................................................................................................... 2
   1.4. What are the aims of this tutorial?.......................................................................................................... 2
  2. The Scenario ................................................................................................................................................ 3
  3. Why Use a UML Class diagram to represent a ERD diagram? ................................................................. 3
    3.1. Differences between UML Class diagrams and ERD’s ....................................................................... 4
    3.2. Starting Up MD/PA ............................................................................................................................... 4
  4. Creating and editing a new Project ............................................................................................................... 5
    4.1. Creating a new diagram.......................................................................................................................... 6
    4.2. Drawing .................................................................................................................................................. 7
    4.3. Creating Classes .................................................................................................................................... 8
    4.4. Editing and Adding Attributes ............................................................................................................. 9
    4.5. Defining a Relationship among the Classes ..........................................................................................11
    4.6. Completing the diagram .......................................................................................................................14
  5. Extended Exercise ..........................................................................................................................................14
  6. Useful Tricks and Tips ..................................................................................................................................15
    6.1. Copying a diagram on the fly to a Word document or other software .................................................15
    6.2. Saving a diagram as a picture ..............................................................................................................15
    6.3. Linking Diagrams ..................................................................................................................................16
    6.4. Adding Documentation to a Diagram ..................................................................................................17
  7. Conclusions for this Tutorial .....................................................................................................................17
  8. Appendix - Installing MagicDraw ............................................................................................................18

Video of this tutorial
You can see this tutorial as the second and third youtube videos at:
http://www.youtube.com/playlist?list=PL5D590974B7967000
1. Introduction

1.1. Acknowledgement

The original version of this handout was designed for a similar piece of software (System Architect), and was developed by Dorothy Dologite and Richard Holowczak, at City University of New York. http://cisnet.baruch.cuny.edu/holowczak/classes/9490/satutorial/ but unfortunately since SA have been taken over by Telelogic there is no longer an educational version of the software. Luckily over the last few years a number of alternative Case tools have become available, the two most important being MagicDraw and Visual Paradigm.

1.2. Where to obtain the software

This depends on who you are:

- Students at The Royal College of Surgeons (Edin.) will be provided with a academic licence, which allows you to use the personal edition. By default you need to download the actual software from the magicdraw site (see below).
- All others can obtain the software by visiting and registering at: http://www.magicdraw.com/ for the free community edition. An alternative with a similar interface is Visual Paradigm (VP-UML).

1.3. Before you begin this tutorial?

Before you work through this tutorial you should have the following knowledge and skills:

- A basic understanding of systems development life cycles
- An understanding of the basic terminology used in Entity Relationship Diagrams
- A working knowledge of Microsoft Windows/ Apple environments including working with multiple applications and windows, dialog boxes, and so on
- Preferably some experience with using a Database Management System such as Access, Oracle or Base in OpenOffice/Libreoffice, although this is not assumed in this tutorial.

If you feel that you are unable to answer yes to any of the above criteria a good starting point is to work through is my Database/ systems modelling course or which this is part see section 8 at: www.robin-beaumont.co.uk/virtualclassroom/contents.html

In 2009 Magicdraw developed a plugin that allows the drawing of Crows feet notation in class diagrams, however this is not available for the personal edition, if you do have access to this plugin I would recommend you try it out for this tutorial.

1.4. What are the aims of this tutorial?

This tutorial is the first in a series to introduce you to using a specific CASE tool, MagicDraw Personal Edition (MD/PA). Because this is the first tutorial it provides you with screen by screen details of what to do. The aim being to familiarise you with the most common, basic features of MD/PA. By the end of this tutorial you will feel confident with navigating around MD/PA and with the basics of drawing Class diagrams. Subsequent tutorials assume you have this knowledge and therefore provide less detailed instructions.

While the complete CASE tool has hundreds of features capable of addressing the complete systems development life cycle, this practical chapter will focus only on a small, but important subset that of creating a ERD (Entity Relationship Diagram).
2. The Scenario

For this tutorial we will be using the following scenario:

The business we are modelling is a Travel Agency. In the Agency, a **Travel Agent** will make one or more **Reservations** for a **Customer**. A Reservation is associated with a particular **Hotel Room** at a particular **Property** and the Hotel room is associated with zero or more reservations over time (I have highlighted the proposed Entity types/Classes).

3. Why Use a UML Class diagram to represent a ERD diagram?

In the past I have introduced ERD diagramming tools then moved onto UML diagramming tools, which invariably has led to confusion and the inability of some students to move onto the more complex aspects of UML. In an attempt to avoid this I have decided to introduce a simplified UML class drawing technique to allow the drawing of a ERD roughly semantically equivalent as a way of demonstrating how ERDs can be created using a UML mindset and also highlight the relationship between ERD’s and UML class diagrams.

The relationship between ERD’s and UML Class diagrams is best shown by comparing the two. Looking above there are two diagrams the right hand one uses ERD symbols for the various relations whereas the equivalent UML diagram makes use of UML equivalent symbols for the associations.

If you do not understand any of the above please refer to section 11 at [http://www.robin-beaumont.co.uk/virtualclassroom/contents.html](http://www.robin-beaumont.co.uk/virtualclassroom/contents.html)

---

## Exercise 1

### UML Association Multiplicity

The multiplicity value of association end A.

- 0 - zero and only zero.
- 1 - one and only one.
- 0..1 - zero or one.
- 0..* - from zero to any positive integer.
- 1..* - from one to any positive integer.
- * - any positive integer.

Simple uml Association multiplicity symbols given above equate to the Cows feet notation used in ERD relationships. Complete the following table to show the various equivalent notations.

<table>
<thead>
<tr>
<th>UML</th>
<th>ERD</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>O</td>
<td></td>
</tr>
</tbody>
</table>
3.1. Differences between UML Class diagrams and ERD’s

It is important to realise that UML class diagrams offer far more options (‘semantic richness’) than ERD’s, and also do not follow some of the conventions of ERDs.

ERD entity attributes conventions:

- Indicate which attributes are Key fields and often include a Unique identifier (ID) field.
- Display Foreign key fields (attributes) which are often added by the modeller or automatically by ERD drawing software with the ‘FK_’ prefix.

In contrast in UML class diagrams:

- You do not indicate which are key fields (attributes) and do NOT include a unique identifier field for each instance, which is called an OID (Object Identifier) as this attribute is assumed to exit.
- You do not indicate foreign Keys (the concept does not exist in uml) but can use a related concept called a qualifier. (I avoid this).

These are important differences to keep in mind when moving from ERD to UML class diagrams.

For this tutorial we will be accepting the ERD conventions. In other words forcing a UML class diagram to work like an ERD.

3.2. Starting Up MD/PA

It is assumed that you have MD/PA installed. See appendix 1 concerning installing MD

In this section, the basic techniques for starting up the MD/PA will be described. MD/PA is a Windows software application that runs within the Microsoft XP operating system. As with most Windows applications, starting SA/SE is simply a matter of clicking the left mouse button on the Windows Start menu as shown here:

Start the program by going to “Start” menu, selecting (All) Programs, then MagicDraw UML then MagicDraw UML by clicking on it as shown below:

The magic draw screen will appear.

After which you may be asked to check or download various updates please select – no. Many of the updates you are offered are not appropriate for the academic version and you will just waste time attempting to install them.
4. Creating and editing a new Project

Before you can do anything in MD/PA you need to either create a new project or open an existing one. We will create a new project which will model the above scenario:

We will initially concentrate on the two classes, Travel agent and Reservation.

To create the new project Choose the menu option File -> New Project

Then Give the new blank project the name Travel agency and select a sensible project location I typed C:\uml\travel agency and clicked the option Create directory for project.

MD/PA then creates and loads the new project:

The MD/PA main screen is divided into main sections:

1. Along the top are the menus and a button / tool bar.

2. The Project pane appears on the top left hand side

3. Properties pane appears in a small window below it.

4. The right hand side of the screen, the diagram pane, is reserved to display open diagrams and models.

All of the details for a particular project, including diagram details, are stored in a database which is often also called an Encyclopedia or Data Dictionary.
4.1. Creating a new diagram

There are several ways to create a new diagram you can either click on the class diagram icon or select the menu option Diagrams -> Class Diagrams.

Select the menu option Diagrams-> class diagram.

Follow the instructions opposite to create a class diagram called travel agency.

Exercise 2

Please carry out what I have described above.
4.2. Drawing

Removing the grid from the drawing canvas

The grid is my pet annoyance! To remove it:

1. Right mouse click anywhere in an empty part of the canvas to bring up this menu.

2. You may need to click on a down arrow first.

3. Unselect Show Grid.

To create a new class, click here.

To create a new Association, click here.

The drawing toolbar can be used for various operations.
4.3.  Creating Classes

Once you have positioned the new class on the canvas a rather cluttered object appears this is because of something called Smart Manipulation – a feature that the company claims makes using the software easier. Basically each of the dots / icons allow you to add / edit or remove various elements from the class to find out more go to help -> user manual. A similar feature exists in Visual Paradigm called the Resource Centric Interface.

There are two types of Smart Manipulators:

1. Small buttons are displayed within the symbol on the diagram pane.

2. Smart Manipulator toolbar, which appears when elements are selected on the diagram pane.
Adding names to classes:

4.4. Editing and Adding Attributes

To add / edit attributes simply select the class then click on the relevant bubble.

<table>
<thead>
<tr>
<th>Name</th>
<th>Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent_id</td>
<td>string</td>
</tr>
<tr>
<td>Agent_name</td>
<td>string</td>
</tr>
<tr>
<td>Agency_phone</td>
<td>string</td>
</tr>
</tbody>
</table>

In this example, I have added 3 attributes to the Travel Agent entity. Also notice that I have specified what type of attribute each is. If you have worked with databases you will be aware that data is classified into a number of types, the five basic divisions are:

- **String or Char** = characters you may also specify how many characters are probably required
- **Numbers** = Integers and real numbers
- **Boolean** = This type of data is where it can only take one of two values such as Yes/no or open/closed etc.
- **Binary** = Media such as pictures / audio and movie files
- **Date/Time**

We will now edit the above attributes to specify exactly what type each is.
Specifying attribute types

The picture below shows you how to set the attribute agency_phone to type string.

The diagram then gets updated to:

```
travel_agent
- agent_id
- agent_name
- agency_phone : String
```

Repeating the above process for the two other attributes results in:

```
travel_agent
- agent_id : String
- agent_name : String
- agency_phone : String
```

Exercise 3

Please carry out what I have described above.
I repeated the above exercise by adding the following attributes and specifying their type in the reservation entity type (class).

<table>
<thead>
<tr>
<th>Name</th>
<th>Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>code</td>
<td>character</td>
</tr>
<tr>
<td>Reservation_date</td>
<td>date</td>
</tr>
<tr>
<td>Room_type</td>
<td>character</td>
</tr>
</tbody>
</table>

Resulting in:

```
<table>
<thead>
<tr>
<th>travel_agent</th>
</tr>
</thead>
<tbody>
<tr>
<td>-agent_id : String</td>
</tr>
<tr>
<td>-agent_name : String</td>
</tr>
<tr>
<td>-agency_phone : String</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>reservation</th>
</tr>
</thead>
<tbody>
<tr>
<td>-code : String</td>
</tr>
<tr>
<td>-reservation_date : date</td>
</tr>
<tr>
<td>-room_type : String</td>
</tr>
</tbody>
</table>
```

**Exercise 4**

Please carry out what I have described above.

**4.5. Defining a Relationship among the Classes**

At this point, two classes have been defined. Now it is time to link these classes in an association. In this example, we will link the classes with a one-to-many association.

Before actually drawing the relationship, take a look at what the MD/PE's help file has to say on the topic of "associations." You can see this by opening the help menu option Help contents then following the details opposite. The latest version of help has moved the required help shown on the left to the third or fourth option down.
At the bottom of the information a list of the types of multiplicity can be seen – given below to refresh your memory.

<table>
<thead>
<tr>
<th>Multiplicity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>zero and only zero.</td>
</tr>
<tr>
<td>1</td>
<td>one and only one.</td>
</tr>
<tr>
<td>0..1</td>
<td>zero or one.</td>
</tr>
<tr>
<td>0..*</td>
<td>from zero to any positive integer.</td>
</tr>
<tr>
<td>1..*</td>
<td>from one to any positive integer.</td>
</tr>
<tr>
<td>*</td>
<td>any positive integer.</td>
</tr>
</tbody>
</table>

Follow the instructions below to create an association.

We can now specify the multiplicities for each end.
Similarly we know that a particular reservation is only associated with one reservation.

Exercise 5
Please carry out what I have described above. Also remember to
4.6. Completing the diagram

The completed scenario consists of four Entities (classes) shown opposite.

If it were a ‘true’ ERD rather than a cross between a UML class diagram and a ERD we would also include Foreign key fields (attributes). That is in the reservation Entity type (class) we would have two more fields (attributes) FK_travel_agent_id and FK_room_id. Similarly room would have FK_property_id.

Similarly if this were a correct UML class diagram, we would not include the Instance (object) IDS such as agent_id and property_id and certainly not have foreign keys.

Exercise 6

Inspect the class diagram opposite and attempt to imitate it:

Also remember to save your project.

Well done you have nearly finished the first tutorial. However there are some very important administrative tasks within MD you need to learn now.

5. Extended Exercise

To give you more practice try the following scenario:

A hotel has a single reception. The reception makes use of a single Diary but the Diary is maintained by numerous receptionists or reservation forms which can be considered to be a type of input via the reception for the diary. The Diary maintains zero or more reservations. A Reservation relates to a single Diary and also a single customer. Customers make reservation(s). Customers can be of two types either vacationers or Business_traveler. Once a customer who has made a reservation actually takes up residence they become a Hotel_guest. One reservation may result in zero or more Hotel_guest(s) but a Hotel_guest always relates to a single reservation. Each Hotel_Guest owns zero or more Vehicles. A room can be booked by zero or more Hotel_guests who can book one or more rooms.

Above is an incomplete solution, three entities/classes are missing. I have also made use of a special type of relation/association called generalisation in two places, you can find out about them in MG help or wait until you have worked through the introduction to UML section 11.4 at http://www.robin-beaumont.co.uk/virtualclassroom/contents.html or just use ordinary relation/associations for now.
6. Useful Tricks and Tips

6.1. Copying a diagram on the fly to a Word document or other software

To copy the diagram on the fly just go to menu option Edit -> copy as EMF file then paste it into Microsoft Word using Ctrl + V

6.2. Saving a diagram as a picture

Exercise 7

Copy your diagram into a word processing document (e.g. Microsoft Word) by using the copy on the fly technique (see above). Then when in the word processor:

- Attempt to reduce the size of the picture by dragging a corner of it on the page so that it takes up about a quarter of a page.
- Copy some text and right click on the picture to bring up the format picture option then select layout -> square. Notice how the text now wraps around it.
- Go to page setup -> orientation to change between portrait and landscape mode.
- Finally read in the word processing help files about creating continuous section breaks so that you can create documents with some pages in portrait and others in landscape orientation. This is important when you have many diagrams in a document.

Mastering these techniques is vitally important to create well presented assignments.

Video of this

This is discussed further on youtube at http://www.youtube.com/theoldorganplayer
6.3. Linking Diagrams

Suppose that you have a complex class diagram and have realized that a number of classes are basically an expansion of one particular class for example in our diagram the Class **Property** could be associated with a number of classes such as Customer, Staff, Bill etc. It is possible to link the two together on two separate diagrams:

The **Property** Class on the diagram then indicates the hyperlink:
6.4. Adding Documentation to a Diagram

You can create Notes on diagrams (4 types) and also Text boxes.

7. Conclusions for this Tutorial

In this tutorial, you have learnt the basic steps for creating and manipulating a simple UML class diagram which can be considered to be similar to an ERD diagram. Because the MD/PE product was not designed for this purpose you may have been confused by the many options that you did not make use of but at the same time it did expose you to the software. Moving on to UML will provide you with an opportunity to make use of many of these options and discover the richness of UML.

Robin Beaumont Monday, Tuesday, 04 October 2011
8. Appendix - Installing MagicDraw

Details for obtaining Magicdraw are given on page 2.

Remember you need the licence/unlock key (in the form of an xml file) saved on your local machine before installing MagicDraw. Make a note of where it is.

During or after installation you are asked to provide a licence/unlock key. Click on the Select unlock key option.

You will then be asked to indicate where the licence/unlock key file is navigate to the correct folder.

You will then be asked which predefined Magicdraw configuration you want. Select System Analyst and then click OK.

You can always change this from the MD menu Options -> Perspectives -> Perspectives.
If/when presented with either of the following two dialogue boxes click **Cancel**.

The first screen should then appear, take some time to read through the information about MagicDraw resources.

When you have had enough Click on the menu option **File -> Close all projects.** You are now ready to begin